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Wat is nieuw

Wat is nieuw in Tl Connect™ CE-software v5.3

Tl CE Bundle-bestand — gebruik één computerbestand om uw CE-rekenmachine bij te
werken!

Werk uw aangesloten CE-rekenmachine(s) in één stap bij met TI Connect™ CE en de
nieuwe Tl CE Bundle die u gedownload heeft van education.ti.com. Dit is een
alternatieve manier om uw rekenmachine in één stap bij te werken.

Zie meer

Programma-editor
HUB -menu voor Tl-Innovator™ en Tl-Innovator™ Rover

De Programma-editor ondersteunt het Tl-Innovator™ HUB-menu voor Tl-Innovator™- en
Tl-Innovator™ Rover-commando's. Het HUB-menu staat in het menu Programma's in
de catalogus-boomstructuur.

Zie meer

Nieuw commando

e Het commando piecewise( is toegevoegd aan de Tl Connect™ CE catalogus-
boomstructuur in Math>Math en ook in de Catalogus. Dit commando ondersteunt
het nieuwe grafiektemplate voor stuksgewijs gedefinieerde functies in CE OS 5.3.

Ga voor meer informatie over de nieuwe en bijgewerkte commando's naar de TI-84
Plus CE Referentiehandleiding op education.ti.com/go/download.
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Inleiding op de Tl Connect™ CE-software

De Tl Connect™ CE-software maakt het uitwisselen van informatie tussen uw grafische
rekenmachine en uw computer snel en makkelijk.

De software ondersteunt alle grafische rekenmachines van de TI-8x-serie met een
USB-poort, waaronder:

e TI-84 Plus CE

e TI-84 Plus CE-T

e TI 84 Plus CSilver Edition
e TI-84 Plus

e TI-84Plus T

e TI-83 Premium CE

e TI-83 Plus.fr

e TI-82 Advanced

Opmerking: Gebruik Tl Connect 4.0 software die rekenmachines ondersteunt die alleen
over een |/0O-poort beschikken:

e TI-83 Plus

e TI-89 Titanium
e Voyage 200

e TI-73 Explorer
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Met behulp van de Tl Connect ™ CE Software

Het van de TI Connect™ CE-software bevat tools die u kunt gebruiken om informatie uit
te wisselen tussen uw rekenmachine en uw computer.

De Tl Connect™ CE-software bevat drie werkruimtes:

e Screen Capture (Schermvastlegging): hiermee kunt u schermvastleggingen beheren

e Calculator Explorer (Rekenmachineverkenner): hiermee kunt u inhoud van

rekenmachines beheren

e Program Editor (Programmabewerker): hiermee kunt u Tl basisprogramma's te

beheren

2 TIConnect™ CE

File Edit View Actions Help

(0] CONNECTED CALC... (1)
SCREEN
CAPTURE

TI-84 Plu... <
0552

jol

CALCULATOR
EXPLORER

[
(1]
PROGRAM
EDITOR

Press [8] to capture calculator screens
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Delen van de Tl Connect ™ CE Software

£2 T Connect™ CE

File Edit Vie

@ CONNECTED CALC... (1) m

TI-84 Plu... m

0552

CALCULATOR
EXPLORER

[]
(1]
PROGRAM
EDITOR

Press [8] to capture calculator screens

3 (4] (5]

o Menubalk - Gebruik deze menu's om rekenmachinebestanden en -schermen
te beheren, informatie over de rekenmachine te bekijken en om hulp te
krijgen.

File Edit Wiew Actions Help

9 Werkbalk - Gebruik deze pictogrammen om computerbestanden en -
schermen te beheren.

o @ [ 100%

9 Werkruimtepaneel - Gebruik dit paneel om werkruimtes te selecteren
(Calculator Explorer, Screen Capture en Program Editor).

CALCULATOR
EXPLORER

u
L L}
PROGRAM
EDITOR

e Paneel Lijst met rekenmachines - Gebruik deze lijst om alle aangesloten
rekenmachines te bekijken en om één rekenmachine te selecteren voor
weergave.
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CONMECTED CALCULATORS (1)

TI-84 Plus CE - 1B29

0550

Inhoudspaneel - Gebruik dit paneel om de rekenmachinebestanden en -
schermen op aangesloten rekenmachine(s) te bekijken en te beheren.

2 TI Connect™ CE

File Edit View

Actions  Help

O] CONNECTED CALC... (1 [8]

CALCULATOR
EXPLORER

(]
(1]
PROGRAM
EDITOR

TI-84 Plu... ©

oss2

*Capture 1

Opmerking: u kunt de meeste van de acties in deze menu's uitvoeren door
items te verslepen en neer te zetten op uw aangesloten rekenmachine of

computer.
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De werkruimte Screen Capture gebruiken

Met de werkruimte Screen Capture kunt u schermvastleggingen van rekenmachines
beheren.

2 TIConnect™ CE

File Edit View Actions Help

B ¥ o

@ CONNECTED CALC... (1) @ NORMAL FLOAT AUTO REAL RADIAN MF n
TI-84 Plu...
0552 m
CALCULATOR
EXPLORER
[]
(T}
PROGRAM

EDITOR

“Capture 2 x

NORMAL FLOAT AUTO REAL RADIAN MP n
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Delen van de Screen Capture Workspace

Menubalk - Gebruik deze menu's om bestanden en afbeeldingen te beheren,
informatie over de rekenmachine te bekijken en om hulp te krijgen.

File Edit View Actions Help

Opmerking: u kunt de meeste van de acties in deze menu's uitvoeren door items
van het Inhoudspaneel te verslepen en neer te zetten.

Werkbalk - Klik op deze pictogrammen om bestanden op te slaan, te verzenden, te
kopiéren, te verwijderen en de afmetingen ervan te veranderen.

[ 100%

Een bestand op de computer opslaan.

Een bestand verzenden naar een rekenmachine.

Een bestand kopiéren.

Een bestand wissen.

Een rand toevoegen aan of verwijderen van alle vastgelegde schermen.

De afmetingen van alle vastgelegde schermen veranderen.

QP00 OOe

De afmetingen van de schermvastlegging bekijken.

Inhoudspaneel - Schermvastleggingen bekijken in het Inhoudspaneel.

*Capture 1 x

1]

NORMAL

FLOAT AUTO REAL RADIAN HP

Schermen vastleggen en gebruiken

In de werkruimte Screen Capture kunt u schermen van uw rekenmachine vastleggen en
bekijken.
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Voordat u begint

Sluit de rekenmachine aan op de computer en zorg ervoor dat verschijnt in de
Calculator List Panel.

Rekenmachineschermen vastleggen

1. Klik op het TI Connect™ paneel Werkruimte van de CE-software op de werkruimte
Screen Capture.

2. Geef het scherm weer op uw rekenmachine dat u wilt vastleggen.

3. Klik op naast de gewenste rekenmachine in het paneel met de lijst met
rekenmachines.

e Als er meer dan één rekenmachine is aangesloten, klik dan op naast
CONNECTED CALCULATORS om schermen van alle rekenmachines vast te leggen.

Rekenmachineschermen opslaan als bestanden

Met de werkruimte Screen Capture kunt u vastgelegde of bestaande afbeeldingen van
uw rekenmachine opslaan als PNG-bestanden.

*Capture 1 X
NORMAL FLOAT AUTO REAL RADIAN MP 1]
|

Opmerking: het sterretje aan het begin van de naam van een afbeelding geeft aan dat
de afbeelding niet is opgeslagen.

Een bestaand scherm opslaan

1. Klik op het vastgelegde scherm in het paneel Content (Inhoud).
2. Klikop Bl

Meerdere schermen opslaan

1. Klik op Edit > Select All (Bewerken > Alles selecteren).

2. Klikop[El

Een schermvastlegging een andere naam geven

1. Plaats de cursor aan het begin van het veld met de schermnaam.
Bv.: Capture 1.

2. Dubbelklik op de naam om deze te selecteren.

3. Typ een nieuwe naam in voor het computerbestand.
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Een nieuwe schermvastlegging opslaan als PNG-bestand

1.

2
3
4.
5

Klik op de afbeelding.
Klik op [E].
Navigeer naar de gewenste locatie voor opslag.

Gebruik de standaard bestandsnaam of typ een nieuwe bestandsnaam in.

Schermvastleggingen naar aangesloten rekenmachines verzenden

De functie Screen Capture Only biedt een manier om een scherm met een grafiek op
rekenmachines met een hoge resolutie vast te leggen, het grafiekgebied bij te snijden
en vervolgens alleen het grafiekgebied te converteren naar een achtergrondafbeelding.
Vink Graph Area Only (Alleen grafiekgebied) aan om dit type achtergrondafbeelding te

creéren.

1. Leg het scherm vast als u dit nog niet gedaan heeft.
2. Klik op de schermvastlegging om deze te selecteren.
3.

Klik op

= Send to Calculators = X el

FILE NAME: NAME ON CALCULATOR: LOCATION: I

Capture 1 Imagel Y: \/

|| Graph Area Only

Screen captures and converted image files will be sent as Pic Vars to black and white
calculators

DESTINATION CALCULATORS:
®) All Connected Calculators o) Select Calculators

|| Replace existing content with the same name on destination calculators

Cancel Send

FILE NAME (BESTANDSNAAM): Deze kan anders zijn dan de NAME ON
CALCULATOR (NAAM OP REKENMACHINE), afhankelijk van welke naam u de
schermvastlegging heeft gegeven op uw computer.

De werkruimte Screen Capture gebruiken 9



NAME ON CALCULATOR (NAAM OP REKENMACHINE): selecteer de
achtergrondafbeelding (dit zou de standaardnaam moeten zijn, maar u kunt de
naam van de achtergrondafbeelding veranderen met dit menu).

Opmerking: schermvastleggingen en geconverteerde beeldbestanden worden als
Pic Vars (afbeeldingsvariabelen) verzonden naar zwart-wit-rekenmachines.

GRAPH AREA ONLY (ALLEEN GRAFIEKGEBIED): Selecteer in het rechterpaneel of u
alleen het grafiekgebied wilt verzenden of het hele scherm. Als u een
schermvastlegging terugzendt naar een rekenmachine, kunt u het best alleen het
grafiekgebied verzenden.

Een afbeelding bijsnijden

Een schermvastlegging van het grafiekgebied bevat het volledige scherm van de
TI-84 Plus CE, de statusbalk, de rand van de grafiek en het grafiekgebied.

Met Tl Connect™ CE-software kunt u de afbeelding bijsnijden tot het de afmeting
heeft van Graph Area Only (Alleen grafiekgebied) om een Background Image Var
(achtergrondafbeeldingsvariabele) te creéren. U kunt een scherm bijsnijden naar
Graph Area only in het dialoogvenster Send to Calculators (Verzenden naar
rekenmachines).

W

WA (R

| Graph Area Only | Graph Area Only

DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u de afbeelding
naar alle aangesloten rekenmachines wilt verzenden, of alleen naar geselecteerde
rekenmachines (in een keuzelijst).

Bestanden verzenden naar meerdere rekenmachines

1.

2.
3.

Selecteer de toets Select Calculators (Rekenmachines selecteren) in het
dialoogvenster.

Plaats een vinkje in de vakjes naast de rekenmachines die u wilt selecteren.

Klik op Send (Verzenden).

Vastgelegde schermen verslepen naar computertoepassingen

Met de werkruimte Screen Capture kunt u vastgelegde schermen verslepen naar tal
van computertoepassingen en ze daarin neerzetten. Met deze functie kunt u
rekenmachineschermen gebruiken in uw documenten.

Schermen verslepen en neerzetten in computertoepassingen

1.

Open het scherm of leg een scherm vast.
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2. Sleep het scherm naar een geopende computersoftwaretoepassing voor
documenten of presentaties en zet het daar neer.

Opmerking: U kunt ook Bewerken> Kopiéren gebruiken> Plakken in een geopend
document of presentator toepassing op uw computer.

De werkruimte Screen Capture gebruiken 11



De werkruimte Calculator Explorer gebruiken

Met de werkruimte Calculator Explorer kunt u inhoud op uw rekenmachine beheren.

£2 TI Connect™ CE = 8] %

File Edit View

m CONNECTED CALCULATORS (1) TI-84 Plus CE Archive: 2,096 kB available | RAM: 152 kB available
SCREEN
CAPTURE T o NAME TeE size LoCATION -
e on U Program 2B RAM
jo) oo Y Program a8 RAM
A oo Program 28 RAM
[ Real List 28 RAM
o ) L Real List 28 RAM
LT}
PROGRAM [ S Real List 28 RAM
EDITOR .
{7} L Real List 28 RAM
{1 Real List 28 RAM
{1 L Real List 28 RAM
1N Thiset Table Setup 208 RAM
1. RclWindw User Zoom Recall Window 208 B RAM
Window Window 2108 RAM
Celsheet Flash Application 123k8 Archive
Conics Flash Application 2k Archive
Deutsch Flash Application 45k8 Archive
EasyData Flash Application 167 k8 Archive
errors Flash Application 1k Archive
Espafiol Flash Application 4548 Archive
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Delen van de Calculator Explorer Main Workspace

Menubalk - Gebruik deze menu's om bestanden en afbeeldingen te beheren,
informatie over de rekenmachine te bekijken en om hulp te krijgen.

File Edit View Actions Help

Opmerking: u kunt de meeste acties in deze menu's uitvoeren door items vanuit het
Inhoudspaneel te verslepen en neer te zetten.

Werkbalk - Klik op deze pictogrammen om bestanden toe te voegen, over te zenden of
te wissen van uw rekenmachine.

= C
0066 0 6

o Inhoud toevoegen vanaf uw computer.

9 Geselecteerde inhoud verzenden naar uw computer.
@ Geselecteerde inhoud verzenden naar een andere aangesloten rekenmachine.
e Het geselecteerde bestand verwijderen.

@ De weergave van de inhoud van een aangesloten rekenmachine vernieuwen.

Inhoudspaneel - Selecteer bestanden die u wilt beheren vanaf dit paneel.

Een aangesloten rekenmachine selecteren

Met de Tl Connect™ CE-software kunt u meerdere rekenmachines tegelijk aansluiten.
Klik op de rekenmachine waarmee u wilt werken om deze te selecteren. De
geselecteerde rekenmachine wordt de standaardrekenmachine voor alle acties van de
Tl Connect™ CE-software.

Voordat u begint

Sluit de rekenmachine aan op de computer en zorg ervoor dat verschijnt in de
Calculator List Panel.

Rekenmachinebestanden naar de computer kopiéren

U kunt de meeste gegevens, bestanden en programma's van uw rekenmachine naar
uw computer kopiéren als back-up van inhoud, om naar anderen te verzenden of om
rekenmachinegeheugen vrij te maken.

Een bestand van de rekenmachine naar de computer kopiéren

1. Klik op de naam van het bestand om het te selecteren.

De werkruimte Calculator Explorer gebruiken 13



2. Versleep en zet het bestand neer in een map op uw computer of op uw
bureaublad.

Om een bestand van de rekenmachine om de computer te kopiéren als een content
back-up

1. Selecteer bewerken
2. Selecteer alles

3. Sleep het bestand naar een map op uw computer of op uw bureaublad.

Let op: Er is geen automatische back-upfunctie hier.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Een bestand van de computer naar de rekenmachine kopiéren

1. Navigeer naar het gewenste bestand op uw computer.

2. Sleep het bestand naar het paneel Lijst met rekenmachines en zet de muis boven
de gewenste rekenmachine.

3. Laat de muisknop los als u + Copy ziet.

Selecteer een bestandsnaam in het vervolgmenu. Dit wordt de naam van het
bestand op uw rekenmachine.

5. Klik op Send (Verzenden).
Bestanden verzenden naar aangesloten rekenmachines

U kunt bestanden verzenden naar rekenmachines die aangesloten zijn op de Tl
Connect™ CE-software.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Bestanden naar aangesloten rekenmachines verzenden

1. Klik op het bestand (s) in Content Panel om deze te selecteren.

2. Klik op .

14 De werkruimte Calculator Explorer gebruiken



=2 Send to Calculators l=lE] &

FILE NAME: MNAME ON CALCULATOR: LOCATION:

KALSCOPE &xp KALSCOPE 24 RAM i

DESTINATION CALCULATORS:

_ All Connected Calculators ®) Select Calculators

of| TI-84 Plus CE-1B89

| Replace existing content with the same name on destination calculators

CANCEL SEND

e DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u het bestand
naar alle aangesloten rekenmachines wilt verzenden, of alleen naar geselecteerde
rekenmachines (in een keuzelijst).

Bestanden naar geselecteerde rekenmachines verzenden

1. Selecteer de toets Select Calculators (Rekenmachines selecteren) in het
dialoogvenster.

2. Plaats een vinkje in de vakjes naast de rekenmachines die u wilt selecteren.

3. Klik op Send (Verzenden).
Achtergrondafbeeldingen converteren en verzenden

De TI-84 Plus CE kan achtergrondafbeeldingen en Pic Vars weergeven. Deze variabelen
wordt weergegeven in het grafiekgebied.

Opmerking: alle informatie over achtergrondafbeeldingen geldt ook voor de TI-84 Plus C
Silver Edition en de TI-83 Premium CE.

Werken met achtergrondafbeeldingen

De Tl Connect™ CE-software converteert een afbeelding die u verzendt naar een
aangesloten rekenmachine automatisch in een achtergrondafbeeldingsvariabele. Uw
afbeelding kan anders worden weergegeven in het grafiekgebied dan u verwacht,
vanwege de conversie naar de pixelafmetingen 83 x 133.
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Opmerking: voor de beste resultaten kunt u uw afbeelding bewerken, zodat deze in
verhouding is met 83 x 133 pixels, voordat u de conversie naar 83 x 133 pixels
uitvoert.

De conversie naar de achtergrondafbeeldingsvariabele gebruikt 16-bits kleur.

U kunt ook een achtergrondafbeeldingsvariabele uploaden naar de TI-84 Plus CE-
emulatorweergave in de TI-SmartView™ CE-software..

Op de TI-84 Plus CE wordt een achtergrondafbeeldingsvariabele alleen als achtergrond
in het grafiekgebied weergegeven. Een achtergrondafbeelding wordt geschaald
weergegeven bij de MODE-scherminstellingen Full (Volledig), Horizontal (Horizontaal)
en Graph-Table (Grafiek-Tabel). Hierdoor blijft eventuele wiskundige modellering die
uitgevoerd is op een achtergrond, bewaard. U kunt een achtergrondafbeelding niet
bewerken terwijl u aan het werken bent op de TI-84 Plus CE. Achtergrondafbeeldingen
wordt uitgevoerd vanaf en opgeslagen in het Archiefgeheugen.

16 De werkruimte Calculator Explorer gebruiken



Een achtergrondafbeelding verzenden naar een aangesloten
rekenmachine

U kunt een achtergrondafbeelding verzenden en deze weergegeven in het
grafiekgebied van de TI-84 Plus CE.

Opmerking: Alle informatie op achtergrondafbeeldingen geldt ook voor de TI-84 Plus
CE-T, TI-84 Plus C Silver Edition en de TI-83 Premium CE.

NORMAL FLOAT AUTO REAL RADIAN MP n

I A A

~

9.

Open de Tl Connect™ CE-software.

Kies de werkruimte Calculator Explorer.

Sluit de TI-84 Plus CE op de computer aan met de kabel.
Zet de TI-84 Plus CE aan.

Kies de afbeelding die u wilt converteren.

Sleep het plaatje naar het paneel Lijst met rekenmachines en zet de muis boven de
gewenste rekenmachine.

Laat de muisknop los als u * Copy zjet.

Selecteer een Image# naam uit het vervolgmenu (Image0 - Image9). Dit wordt de
naam van de afbeelding op de TI-84 Plus CE.

Opmerking: de naam van het Image#-bestand die u kiest wordt de naam van de
afbeelding op uw rekenmachine. Onthoud de naam van Image# (of maakt deze
onderdeel van de bestandsnaam op uw computer) om deze te kunnen herkennen
wanneer u dit bestand wilt verzenden of delen.

WAARSCHUWING: Voorgeladen afbeeldingen zijn opgeslagen in Imagel - Image5.
Gebruik een ander Image# om te voorkomen dat u de voorgeladen afbeeldingen
overschrijft.

Klik op Send (Verzenden).

Opmerking:Geef het computerbestand een andere naam, zodat u uw Image Var later
kunt herkennen (brug, fontein enz.). De interne rekenmachinevariabelenaam Image#
wordt niet gewijzigd.
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Opmerking: Om de achtergrondafbeelding op te slaan op uw computer, sleept u het
Image# van de Calculator Explorer naar uw bureaublad of naar de map waarin u het
wilt opslaan.

e Om uw nieuwe achtergrondafbeelding weer te geven in het grafiekgebied van de

TI-84 Plus CE drukt u op [FORMAT], verandert u de instelling Background
(Achtergrond) naar het Image# dat u zojuist naar de rekenmachine heeft verzonden

(bijvoorbeeld: Image5), en drukt u op [GRAPH].

Opmerking: Vanaf het grafiekscherm op de rekenmachine kunt u de achtergrond
ook veranderen met het interactieve commando [draw]; BACKGROUND;
1:BackgroundOn.

Gegevensimport

Met de functie Data Import (Gegevensimport) kunt u spreadsheetgegevens die
opgeslagen zijn als cvs-gegevensbestanden converteren en verzenden naar de
rekenmachine als rekenmachinelijst(en) of een matrixbestand.

U krijgt toegang tot de functie Data Import vanuit de werkruimte Calculator Explorer.

Belangrijkste punten:
e (Creéer (of download) een spreadsheet met gegevens.

e Voordat u importeert, moet u de gegevens in uw spreadsheetsoftware bewerken
tot een door de rekenmachine toegestane numerieke opmaak (hieronder
gespecificeerd) voor de import naar een rekenmachinebestand.

Over de spreadsheet

e Er wordt slechts één spreadsheet die is opgeslagen als een CSV (Comma
Delimited) (*.csv)-bestand tegelijk geimporteerd via de werkruimte Calculator
Explorer.

e Het spreadsheet (csv)-bestand kan naar de Calculator Explorer gesleept worden of
geimporteerd worden via het menu Actions > Import Data (.csv) to Lists/Matrix...

e Maximaal 6 rekenmachinelijsten of 1 matrix uit de spreadsheet-gegevens worden
naar de aangesloten rekenmachine verzonden.

Regels voor het klaarmaken van de spreadsheet voor import:

e Alle cellen moeten gegevens bevatten, die op de rekenmachine ervaren worden als
reéle getallen, en geen tekst.

- Complexe getallen worden niet ondersteund bij gegevensimport.
e De gegevens moeten startn in cel Al

e Importeren van lijst(en): als u rekenmachinelijsten wilt importeren:
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2 Import your Data = El|

Prior to importing your spreadsheet saved in csv file format, make
sure your data starts in cell A1, contains only Real numeric values,
and does not contain text.

Select calculator file type for conversion:

FILENAME: 08 compaes_clean_matrix or list.csv
COLUMNS:

{4 Lists ~ 1 v

CANCEL CONTINUE

- alleen de zes spreadsheet-kolommen A-F worden geimporteerd
- Kolommen kunnen maximaal 999 cellen bevatten.

- De eerste lege cel in een kolom wordt geinterpreteerd als het einde van de
gegevens voor de import van die lijst

e Importeren van een matrix: als u een rekenmachinematrix wilt importeren:

Prior to importing your spreadsheet saved in csv file format, make
sure your data starts in cell AL, contains only Real numeric values,
and does not contain text

Select calculator file type for conversion:

FILENAME: 01 testcsv

ROW: <ol CEUS:
(] Matrix v 2% 2 4
Up t0 400 cell:
CANCEL CONTINUE

- Erkan slechts één matrix geimporteerd worden uit een spreadsheet-bestand.

- Er kunnen maximaal 400 cellen geimporteerd worden. (Voorbeeld: rij x kolom:
10 x 5 = 50 cellen van de rijen 1-10, kolommen A-E.)

- De afmetingen van de matrix in de vorm (rij x kolom) worden gevraagd tijdens
het importeren in Calculator Explorer.

- Elke lege cel binnen de gespecificeerde matrix wordt geinterpreteerd als 0.

e Laat geen gegevens in de spreadsheet vallen buiten de toegestane afmetingen
voor lijst(en) of matrices, zoals hierboven beschreven. Anders is het bestand
ongeldig als u de gegevens probeert de importeren naar Calculator Explorer.

Rekenmachinelijst(en) of matrixbestanden opslaan

e Om rekenmachinebestanden die gecreéerd zijn op de computer na het importeren
of verzenden naar de rekenmachine op te slaan, sleept u de lijst(en) of het

matrixbestand van de Calculator Explorer naar de gewenste locatie op de
computer.
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Rekenmachinebestanden wissen

U kunt gegevens, bestanden en programma's wissen van uw rekenmachine.

Bestanden wissen van de rekenmachine.

1. Klik op het bestand in de Content Panel die u wilt verwijderen.

2. Drukop .
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De werkruimte Program Editor gebruiken

De werkruimte Program Editor stelt u in staat om te werken met Tl basisprogramma's.

2 TI Connect™ CE =

File Edit View Actions Help

=
|

SCREEN
CAPTURE

o)

CALCULATOR
EXPLORER

New Program

_|_

Open Program

-
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Onderdelen van de werkruimte Programma-editor

2 TIConnect™ CE 2| B S|

File Edit View Actions

+ =

SCREEN
CAPTURE

ol

CALCULATOR
EXPLORER

New Program

Open Program

-

o Menubalk - Gebruik deze menu's om bestanden en programma's te beheren
en hulp te krijgen.

File Edit Wiew Actions Help

Opmerking: in de werkruimte Programma-editor kunt u alleen
programma's naar het Inhoudspaneel slepen en ze daar neerzetten.

9 Werkbalk - Klik op deze pictogrammen om een nieuw programma te maken,
een programma te openen, een programma op te slaan op de computer, een
programma te verzenden naar aangesloten rekenmachine(s), een bewerking
ongedaan te maken of opnieuw uit te voeren en de lettergrootte te veranderen
met een schuifknop.

+ @B B © c e A
06 o (5] (6]

©® Nieuw programma maken.

@® Programma openen.
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Programma opslaan op computer.

Programma verzenden naar aangesloten rekenmachine(s).

Een bewerking ongedaan maken of opnieuw uitvoeren.

Q0 Qo

Schuifknop Lettergrootte gebruiken om tekst groter of kleiner te
maken in:

e (Cataloguspaneel
e Programma-editor

Inhoudspaneel - Gebruik dit paneel om programma's te creéren, te bekijken
en te bewerken.

New Program

Open Program

-

Cataloguspaneel - Gebruik dit paneel om uw rekenmachinetype te selecteren
en vervolgens uit lijsten in de catalogus te kiezen (op categorie) om
programma's te creéren.
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» Keypad

» Angle

» Catalog

» Char

*» Distribution
*» Draw

* Finance

» Format

» List

» Math

» Matrix

* Memory

» Mode

* Program

» Statistics
» Stat Plots
» Table Setup
» Test

» Variables

» Zoom

Syntax-referentiepaneel - Gebruik dit paneel om de juiste syntax van elk
commando te bekijken, samen met de vereiste en optionele argumenten.

1,prgnA

Een nieuw programma maken

Als er geen programma's geopend zijn, dan geeft het Inhoudspaneel alleen de
pictogrammen New Program (Nieuw programma) en Open Porgram (Programma
openen) weer.
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Een nieuw programma maken New Progeam

» Klik op het pictogram New Program (Nieuw
programma).

Een bestaand programma openen

Open Program

1. Klik op het pictogram Open Program

(Programma openen). -—‘

Navigeer naar de juiste map.
Klik op Open (Openen).
Een Var-naam bewerken

Namen van nieuwe programma's zien er als volgt uit: PROG##. De nummers lopen op,
bv.: PROGO1, PROGO02.

De naam van een programma veranderen

» Klik in het vakje Var Name en typ een nieuwe naam van maximaal 8 letters of
cijfers (het eerste teken mag geen cijfer zijn).

VAR NAME: PROGO1

Uw programma beveiligen

Met de Tl Connect™ CE-software kunt u uw programma beschermen tegen bewerking
nadat het programma naar een aangesloten rekenmachine is verzonden.

Uw programma beveiligen

> Klik op het selectievakje naast het slotje. e
Een programma opslaan op uw computer

Het sterretje aan het begin van de naam van een programma geeft aan dat het
programma niet is opgeslagen.

Een programma opslaan

1. Klik op .

2. Navigeer naar de juiste map.
3. Klik op Opslaan.

Een programma sluiten
Een programma sluiten

» Klik op de x naast de naam van het programma.
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Het Cataloguspaneel gebruiken

Het Cataloguspaneel bevat een lijst met rekenmachinecommando's, functies,
variabelen en symbolen die u kunt gebruiken om programma's te maken.

Een Catalogus-niveau uitvouwen of samenvouwen

» Klik op het driehoekje naast elk Catalogus-onderdeel.

TI-84 Plus CE e *Untitled1.8xp X

» Keypad

» Angle VAR NAME: | PROGO7
» Catalog

» Char

Distribution o
Draw

>
»>
» Finance
>
>

Format
List
¥ Math
» Math
» Numeric
» Complex
» Probability
¥ Fraction
I
MEARD
rnfd4rUnid
» Matrix
» Memory
» Mode
» Program

» Statistics
» Stat Plots
» Table Setup
» Test

» Variables

» Zoom

Reference

No reference available

Een Catalogus-onderdeel in het Inhoudspaneel plaatsen

> Sleep het Catalogus-onderdeel naar het Inhoudspaneel en zet het daar neer.
Hierdoor wordt de cursor in de commandoregel van de Program Editor geplaatst
nadat het is neergezet.

-OF-
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> Dubbelklik op het Catalogus-onderdeel. Hierdoor wordt het onderdeel in de
Program Editor geplakt; de focus blijft in het Cataloguspaneel, zodat u nog een
onderdeel kunt selecteren. Klik aan het eind van de commandoregel om door te
gaan met typen in de editor.

Syntax-fouten voorkomen:

Gebruik de catalogus met commando's en symbolen om deze in de editor te plakken
om syntax-fouten, als gevolg van onjuist gebruik van hoofdletters en kleine letters in
commando's, te voorkomen.

Voorbeeld:
Heeft u Eval( of eval( ingetypt?

Heeft u sin( of Sin( ingetypt?

De cataloguslijst plakt de
juiste opmaak met (LR i “Untitled18xp X

hoofdletters, kleine =

. DispGraph
letters en spaties. DispTable VARNAME | PROGOL
»OMS
Dot-Thick
Dot-Thin
DrawF

l Ba eval (

DrawInv
Ds<(

e

at(

E

PEFF(
Else
End

Eng
EqurString(
ExecLib
expr(
ExpReg
ExprOff
Expron
Fedf(

Syntax Reference

eval
Real
8 sig digits

e

Syntax-fouten door extra spaties

Een programma uitvoeren op een rekenmachine

Extra spaties kunnen een syntax-fout veroorzaken bij het uitvoeren van een programma
op de rekenmachine.
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Waar zijn de extra spaties?

VARNAME: SNAKE

U kunt extra spaties in uw programma
zien met de Tl Connect™ CE Program
Editor, door het gehele programma te
selecteren. Extra spaties aan het eind
van commandoregels moeten
verwijderd worden voordat het
programma naar de rekenmachine
wordt verzonden.

Wanneer het programma op de rekenmachine wordt uitgevoerd en er extra spaties
zijn, dan wordt door Goto te selecteren op het syntax-foutenscherm de cursor op de
programmaregel gezet waar de fout is opgetreden. Controleer de regel op de juiste
syntax en extra spaties aan het eind van de commandoregel.

VARNAME:  SNAKE

URMAL FLOAT AUTA REAL RADIAN MP n
(PROGRAM LINE 11

ERROR: SYNTAX

ClrHome

1:Quit

13-A
548
124X
1+P
3440

: Xedin(L1)
:X+dim(L1) Xadin (L2)
:X>dim(L2) P

(F111(B,L1)
R :

tFill(A,Lz2) / ) )
Rereat KE45 Output (8,A,°0")

/] BaL1 (P)
£ ALz (P)
/ P+1-X(P=X)~P
tKey+K
Cursor lands on error: 3 o (ke(24,25,26,34})
K+D

A+ (D=26)- (D=24) +A
B+(D=34)- (D=25)-B
A+26( (A=D) - (A=27))-A
B+1@((B=0)-(B=11))+B
End

e Ga met de cursor naar het eind van die commandoregel.

e Verwijder extra spaties zorgvuldig.

Opmerking: op de rekenmachine is er geen functie Ongedaan maken.
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WORMAL FLOAT AUTO REAL RADIAM HF
FROGRAH LIME ?

HORRAL FLOAT AUTO KEAL RABIAN riF n

)
PROGRAM : SNAKE PROGRAM : SNAKE
:ClrHome :ClrHome
:13+A +13+R
548 1548
110X P104X
1P 1P Spaces

134D 134D

) |:Xdim(Lal :X+dim{L1) B
i¥+dim(Lz) i¥+dimilz )
tFill(B.L1} :Fil1l1(B.L1)

Wanneer worden commando's rekenmachinecommando's (tokens)?

De commando's worden pas rekenmachinecommando's (tokens) als het programma
naar de rekenmachine is verzonden.

Als er een fout is wanneer uw programma naar de rekenmachine wordt verzonden of
op de rekenmachine wordt uitgevoerd, controleer dan of elk commando in de
programmabewerkingsmodus van de rekenmachine ook echt een commando-token is.

Hoe weet je dat?

Wanneer een commando een token op de rekenmachine is, dan staat de cursor op het
eerste teken en springt vervolgens over het commando heen als een token. Als de
cursor letter voor letter door een commando beweegt, dan is dat commando niet
omgezet. Verwijder en plak het commando van de rekenmachine.

PROGRAM: B PROGRAM: B On the calculator, the cursor
— :EnvBinom( tinvBinom(H

jumps over the “token.”

It only understands the
characters as a function or

command name.

Geheugensteuntje: wanneer een programma rechtstreeks op de rekenmachine wordt
ingevoerd, dan wordt het commando of de functie in zijn geheel als token geplakt.

Waarschuwing: Sommige rekenmachinecommando's, zoals LINKS, MIDDEN, RECHTS,
BREUK, zijn woorden die u misschien wilt gebruiken in een string. Als een woord dat u
gebruikt in een string hetzelfde is als een rekenmachinecommando, dan wordt uw
woord een rekenmachine-token en kan dit fouten veroorzaken in uw programma.
Gebruik geen woorden of delen van woorden die hetzelfde zijn als een TI-Basic
commando om onbedoelde token-vorming van een commando te voorkomen.

Waarschuwing: de taalinstelling van Tl Connect™ CE bepaalt hoe de tekst
geinterpreteerd wordt als een commando-token voor de rekenmachine. Het openen
van programma's en het terugzenden naar de rekenmachine met Tl Connect™ CE in
verschillende talen kan resulteren in:

e ongewenste commando-tokens en/of

¢ syntax-fouten
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Het Syntax-referentiepaneel gebruiken

Het Syntax-referentiepaneel geeft de syntax van elk Catalogus-onderdeel weer, met de
vereiste en optionele argumenten.

HUB -menu voor TI-Innovator™ en TI-Innovator™ Rover

De Programma-editor ondersteunt het Tl-Innovator™ HUB-menu voor Tl-Innovator™- en
Tl-Innovator™ Rover-commando's. Het HUB-menu staat in het menu Programma's in
de catalogus-boomstructuur. De toevoeging van het HUB-menu aan de Tl Connect™ CE
programma-editor is dezelfde HUB-menu-ervaring als wanneer de Hub App op de CE-
rekenmachine geladen is. Gebruik altijd de nieuwste versies van het CE OS en de CE
Hub App.

Zie ook:
Het Cataloguspaneel ¥ Frogram
gebruiken b s
Een programma ver;enden » Tnput/Output
naar een rekenmachine B
¥ Colar
* HUE
» Sond("SET
® Send| "READ

kB Settings
Wait
Get |
eval
® Rowver (RV)...
end [ "CONNECT-Output
end [ "CONNECT - Input

AL

k Ports

e Send| "RANGE

» Send | "AVERAGE

# Send|"DISCONMNECT -Output

# Send | "DISCONNECT-Input
* Hanage
Een programma verzenden naar een rekenmachine
U kunt een programma verzenden naar een aangesloten rekenmachine.

Een programma verzenden naar een aangesloten rekenmachine

1. Sla het programma op, als u dit nog niet gedaan heeft.

b
2. Klik op .
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FILE NAME (BESTANDSNAAM): Deze kan anders zijn dan de NAME ON
CALCULATOR (NAAM OP REKENMACHINE), afhankelijk van welke naam u het
programma heeft gegeven op uw computer.

NAME ON CALCULATOR (NAAM OP REKENMACHINE): selecteer de naam van het
programma (dit zou de standaardnaam moeten zijn, maar u kunt de naam van het
programma veranderen door op Custom (Aangepast) te klikken.

2 Send to Calulators =IoIxI® £ Name on Calculator E=E ]

FILE NAME: NAHE Ol CALCULATOR: LocaTIoN:

Untiled1 xp PROGOL > RAM B

cust
DESTINATION CALCULATORS: o Custom Program names can be up to 8 characters in length

All Connected Calculators. ® Select Calculators The first character can be A-Z or 8,
The remaining characters can be A-Z, 6 or0-9

W TI-84 Plus CE-ADAD

| CANCEL
! cacer senp

LOCATION (LOCATIE): Kies of u het programma wilt opslaan in het RAM of in het
archief van de rekenmachine.

DESTINATION CALCULATORS (DOELREKENMACHINES): Selecteer of u het
programma naar alle aangesloten rekenmachines wilt verzenden, of alleen naar
geselecteerde rekenmachines (in een keuzelijst).

Programma's verzenden naar meerdere rekenmachines

1. Selecteer de toets Select Calculators (Rekenmachines selecteren) in het

dialoogvenster.

2. Plaats een vinkje in de vakjes naast de rekenmachines die u wilt selecteren.
3. Klik op Send (Verzenden).

Taalinstellingen

Als u een TI-Basic programma in een andere taal wilt ontwikkelen dan in de ingestelde
taal van het besturingssysteem van uw computer, dan kunt u TI Connect™ CE opnieuw
starten in een andere taal.

1. Selecteer File > Change Language (Bestand > Taal wijzigen).

2. Selecteer de taalverandering na het opnieuw starten van de toepassing.
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=2 Choose a language | = x|

Language changes will take effect after application restart.

English (US) hd

QUIT LATER QUIT NOW CANCEL

e QUIT LATER (LATER AFSLUITEN) - Bewaart de geselecteerde taal; Tl Connect™ CE
start in deze geselecteerde taal de volgende keer dat Tl Connect™ CE wordt
gestart.

e QUIT NOW (Nu STOPPEN) - Sluit de software app. Tl Connect ™ CE zal lanceren in
deze geselecteerde taal de volgende keer dat Tl Connect ™ CE wordt gelanceerd.

e CANCEL (ANNULEREN) - De taal wordt niet gewijzigd. De taal van het
besturingssysteem van de computer is de standaardtaal.
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Uw rekenmachine onderhouden

Het besturingssysteem van uw rekenmachine updaten

Met de Tl Connect™ CE-software kunt u besturingssystemen voor grafische
rekenmachines downloaden.

Voordat u begint

Maak een back-up van uw rekenmachinebestanden (RAM, Archief en Apps).

Zorg ervoor dat uw rekenmachine aanstaat en goed is aangesloten op de
computer.

Als er meerdere rekenmachines aangesloten met een USB-computerkabels, kan OS
transfers plaatsvinden op specifieke rekenmachines.

Dit kan door het selecteren van de specifieke rekenmachines in het dialoogvenster
verzenden.

Waarschuwing: Maak de kabel niet los tijdens het verzenden van gegevens.

Besturingssystemen van grafische rekenmachines updaten

1.
2.

Klik op Actions > Send OS (Acties > OS verzenden).

Navigeer naar het juiste OS-bestand voor uw model rekenmachine dat opgeslagen
is op uw computer.

Klik op Open (Openen).
De Send OS dialoog wordt geopend.

e (D

4. U kunt kiezen uit Bestemming Rekenmachines:
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DESTINATION CALCULATORS:

All Connected Calculators #® Select Calculators

of| TI-84 Plus CE-12A2

SEND
5. Druk op Verzenden

Tl CE Bundle-bestand — gebruik één computerbestand om uw CE-
rekenmachine bij te werken!

Werk uw aangesloten CE-rekenmachine(s) in één stap bij met TI Connect™ CE en de
nieuwe Tl CE Bundle die u gedownload heeft van education.ti.com. Download altijd de
nieuwste TI CE Bundle op education.ti.com.

Sluit uw CE-rekenmachine(s) aan op Tl Connect™ CE. Sleep de gewenste Tl CE Bundle
naar de Calculator Explorer.

e TI-84 Plus CE/CE-T: TI84CEBundle-5.3.0.xxxx.b84
e TI-83 Premium CE: TI83CEBundle-5.3.0.xxxx.b83

Tl Connect™ CE werkt uw CE OS bij en ook CE-apps die bijgewerkt moeten worden of
die ontbreken op uw rekenmachine(s) en laadt tevens de 5 voorgeladen Image Vars
naar Imagel — Image5. Het proces kan niet worden gestopt, dus zorg ervoor dat u uw
favoriete rekenmachinebestanden opslaat (wegsleept) met behulp van de Tl Connect™
CE Calculator Explorer. U kunt uw favoriete rekenmachinebestanden vervolgens
terugslepen naar uw rekenmachine, nadat het nieuwe TI CE Bundle-proces voltooid is.

Sleep de gewenste CE Bundle naar de Calculator Explorer. Wacht tot het volledige
proces voltooid is. Trek de kabel niet los tijdens het verzenden van gegevens. De CE-
rekenmachine kan opnieuw opstarten voor het overzenden van Image Vars en Apps. De
CE-rekenmachine kan een defragmentatie uitvoeren (het geheugen opnieuw ordenen)
op enig moment tijdens het proces. Tijdens het overzenden worden er berichten
weergegeven in het Tl Connect CE-venster.

Opmerking: Haal het Tl CE Bundle-bestand niet door elkaar met het CE OS- en CE App-
bestand dat nog steeds apart gedownload kan worden op education.ti.com. De Tl CE
Bundle bevat alle nieuwste bestanden die u moet bijwerken of herstellen op uw CE-
rekenmachine(s) alsof u uw rekenmachine net gekocht hebt, en biedt een snelle
manier om uw serie CE-rekenmachine(s) in de klas bij te werken.

Belangrijk: Als het bericht "Waiting..." (Wachten...) op het scherm van de CE-
rekenmachine verschijnt, is de rekenmachine het OS kwijtgeraakt. Dit kan gebeuren als
er een kabel is losgetrokken uit de rekenmachine of computer tijdens een het
overzenden van bestanden. Als de kabel wel aangesloten is, koppel hem dan los en
sluit hem weer aan op de computer. Sleep de gewenste CE Bundle naar de Calculator
Explorer.
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Onthoud: Wacht tot het volledige proces voltooid is. Trek de kabel niet los tijdens het
verzenden van gegevens. De CE-rekenmachine kan opnieuw opstarten voor het
overzenden van Image Vars en Apps. De CE-rekenmachine kan een defragmentatie
uitvoeren (het geheugen opnieuw ordenen) op enig moment tijdens het proces. Tijdens
het overzenden worden er berichten weergegeven in het Tl Connect CE-venster.

U kunt dit proces herhalen; dan verzendt de CE Bundle de bestanden opnieuw. Trek de
kabel niet los tijdens het verzenden van gegevens.

Zie ook:
Het besturingssysteem van uw rekenmachine updaten

Bestanden verzenden naar aangesloten rekenmachines

Informatie over de rekenmachine krijgen

Met Tl Connect™ CE-software kunt u informatie over uw rekenmachinetype, product-ID,
0OS-versie, RAM, archief, taal, ROM-versie en hardwareversie krijgen.

Opmerking: Calculator informatie is alleen beschikbaar vanaf de Calculator Explorer
Work Space.

Informatie over de rekenmachine bekijken

> Klik op View > Calculator Information (Bekijken > Rekenmachine-informatie).

=4 Calculator Information = P9

Calculator: TI[-24 Plus CE
PreductID: 13000012A2

————— 0S5 Version: 5.2.0.30
RAM: 262 kB (152 kB available)
Archive: 4,194 kB (2,096 kB available)

L Language: ENGLISH
ROM Version: >.0.0.89
Hardware Version: &
CLOSE
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Compatibiliteit met grafische rekenmachines

Raadpleeg de TI-84 Plus CE Starthandleiding voor informatie over compatibiliteit met
grafische rekenmachines. Zie ook de TI-83 Premium CE Starthandleiding.

Opmerking: in het algemeen zijn bestanden van TI-84 Plus CE grafische rekenmachines
compatibel met andere TI-84 Plus- en TI-83 Plus-modellen.

Apps, besturingssytemen en bepaalde gegevensbestanden met niet-ondersteunde
numerieke typen kunnen niet gedeeld worden tussen modellen.

TI-Basic programma's moeten mogelijk aangepast worden om correct weergegeven te
kunnen worden op modellen met kleurenschermen met een hoge resolutie.
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Algemene Informatie

Texas Instruments Ondersteuning en Service

Algemene informatie Noord- en Zuid-Amerika

Startpagina: education.ti.com
Kennisbank en vragen per e-mail: education.ti.com/ondersteuning
Telefoon: (800) TI-CARES / (800) 842-2737

Voor Noord- en Zuid-Amerika en
Amerikaanse gebieden

Internationale contactinformatie: education.ti.com/ondersteuning/wereldwijd

Voor technische ondersteuning

Kennisbank en ondersteuning via e-mail: education.ti.com/ondersteuning of
ti-cares@ti.com
Telefoon (niet gratis): (972) 917-8324

Voor product (hardware)-service

Klanten in de VS, Canada, Mexico en gebieden van de VS: Neem altijd contact op met
Texas Instruments Customer Support voordat u een product terugzendt voor service

Voor alle andere landen:
Voor algemene informatie

Neem voor meer informatie over Tl-producten en -diensten contact op met Tl via
e-mail of ga naar de website van Tl

Vragen per e-mail: ti-cares@ti.com
Startpagina education.ti.com
Service- en garantie-informatie

Zie voor informatie over de duur en de voorwaarden van de garantie of over
productservice het garantiecertificaat bij dit product, of neem contact op met uw
plaatselijke Texas Instruments-leverancier/-distributeur
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